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Wilf Campus YU TechHub Service Desk

Visit the walk-up Service Desk located on the
6t floor in Belfer Hall, for assistance with any INFORMATION TECHNOLOGY
of the following:

e Password Reset

Py
YU TechHub:

e Wifi Connectivity
* MFA Registration 0

« MS Authenticator App YU TGChH“b}ZT
* (Canvas & Zoom Questions

* PaperCut Printing Assistance
* Self-Service Portal Access WELCOMES YOU!
 C(Classroom & Computer Labs Locations

e And much more........



How To Find
Your Default

Credentials

=i
=0

= To Find your YU username name, instructions to reset your YU password and
Banner ID, go to http://yu.edu/findid.

FIND YOUR ACTIVE DIRECTORY ACCOUNT NAME AND EMAIL ADDRESS

ENTER YOUR LAST NAME AND BANNER ID OR SOCIAL SECURITY NUMEBER
LAST NAME:| |

BANNER ID:| |
or SOCIAL SECURITY NUMBER;| | (Vo dashes)

Submit Clear Result

= Enter your last name, Banner ID or Social Security Number (SSN).

= Once you enter this information you will receive further instructions on how to
login to University systems and set a strong password.

Note: Your Active Directory ID Iﬁ%ay also be called your YUAD account.
YUAD stands for Yeshiva University Active Directory.



Accessing Office 365

Go to Office.com and sign-in
with your YU-Email address
and your “YUAD default
password” gathered from
“Find ID.”

You will need to forget your
wireless connection on all
devices and reconnect with
your new credentials.

o

Update verification
information (add personal
email and cell phone
number). This will allow you
to reset your password
yourself if you forget your
password.

Download your “Free
Microsoft Office365 License.”

You will need to sign into
your Microsoft Applications
on the computer, phones and
tablets; you’ll be prompted
for the new password.

Download the Mobile App
from the Apple or Google
Play store.



Changing your YUAD Password

Sign-into https://office.com
with your YU email address
and current password.

Follow the instructions for
secondary validation using
cell phone and alternate
email.

The alternate email should
not be your YU email address.

Click on your profile picture in
the top right corner of the
screen and select View
account or My Account.

Under Password security, click
on Change your password.

Enter your current password
and then enter a new
password.

Use the password strength
meter to check how secure
your password is.
Passwords must be at least 12
characters long.
Passwords can’t contain the
user's account name or parts
of the user's full name that
exceed two consecutive
characters.

Passwords must contain
characters from three of the
following four categories:

Uppercase letters (A through Z) Sammerd Lowercase letters (a through z) e

Numbers (0 through 9)

One or more of these non-
alphabetic characters:
I@HSHN&F () _+-={
ITIN:"5'<>2,./




MFA Registration

Registering using Phone or Alternate Phone
[Must be performed at a minimum]

1. Beginning 7/8/24 user will be prompted to configure

2. Click on the https://aka.ms/mfasetup to begin registration

3. Sign-in with your YU email address and YUAD password
1. Select the appropriate option to verify your identity and provide the information.

2. If your phone number is already present, choose Enable two-step verification.
1. Choose either text or call me and choose Next.

1. If you chose text, enter the code from your mobile device that was
provided and choose Next

2. If you chose call me, Microsoft will now call you at the number
provided, click the # key to verify yourself.

2. At the phone SMS verified screen, click Done.

3. If your phone number is not present,
1. Atthe security info screen, choose Add sign-in method.

2. Atthe Add a method screen, use the down arrow and choose Phone (this
should be your mobile where you can receive text messages or calls) or
Alternate Phone

3. Enter your phone number and choose Next

4. Microsoft will now call you at the number provided, click the # key to
verify yourself.

5. ét the Call answered. Your phone was registered successfully screen, click
one.

6. If you have not done so already, it is recommended that you setup the
Microsoft Authenticator application on your phone or another device
(such as a tablet).

Registering using Microsoft Authenticator App
[Recommended and helpful if you are traveling internationally]
1. Download the Microsoft Authenticator application from the Apple Store

or Google Play store. Be sure to select Microsoft Authenticator since
there are many different authenticator applications that may be shown.

Choose Add work or school account.
On the more information required screen, click Next

You will need to confirm your authentication

A Sl S

On the additional security verification, choose send me a code by text
message or call me, click Next.

6. Click Done after you validate the information. This concludes the MFA
setup on the app.

7. Please Register your phone number in the Security information using
instructions provided in the next column.


https://aka.ms/mfasetup
https://apps.apple.com/us/app/microsoft-authenticator/id983156458
https://play.google.com/store/apps/details?id=com.azure.authenticator

Cybersecurity Tips

Identity thieves are constantly trying new ways to compromise your
devices and to steal your personal information. Phishing schemes have
increased significantly and are getting more sophisticated. Users need to
be extra vigilant when checking email or going online.

The steps below can also help you stay more secure:

* Make sure you have the latest patches and antivirus updates on your
computer and other mobile devices, including smartphones, tablets,
and laptops.

* Never give anyone your username, password, or any other personal
information. You are responsible for any actions or consequences that
involves your AD account.

* Do not open emails, attachments, or links from unknown sources.

* Do not visit untrusted websites; this will reduce any chances of your
computer or device getting infected with malware.

e Physical security of your devices is also important; make sure you
enable password PINs on your devices, in case they are ever lost or
stolen.

* Visit YU ITS Technology Portal, click on “Policies & Compliance, ITS
Computer Policy.”



http://www.yu.edu/itsportal

Cybersecurity Tips

Identity thieves are constantly
trying new ways to compromise
your devices and to steal your
personalinformation. Phishing
schemes have increased
significantly and are getting
more sophisticated. Users
need to be extra vigilant when
checking email or going online.

These steps can also help you
stay more secure: Complete the
monthly ITS Security

Training when you receive an
email from no-
reply@securitytraining.yu.edu

o

>

(>

Never give anyone your
username, password, or any
other personal information.
You are responsible for any
actions or consequences that
involves your AD account.

Do not open emails,
attachments, or links from
unknown sources.

Physical security of your
devices is also important;
make sure you enable
password PINs on your
devices, in case they are ever
lost or stolen.

Make sure you have the latest
patches and antivirus updates
on your computer and other
mobile devices, including
smartphones, tablets, and
laptops.

Do not visit untrusted websites;
this will reduce any chances of
your computer or device getting
infected with malware.



mailto:no-reply@securitytraining.yu.edu
mailto:no-reply@securitytraining.yu.edu

Insidetrack New Look (https://insidetrack.yu.edu)

== (‘ : Yeshiva University

B>

Home

Main Menu

Q Discover

YU's Helpdesk service to
faculty, staff, and students
with an expanded 7x24x365

We welcome your feedback on
our portal project Teams Site.

. Your comments are public.
service. =
@ Employee 1:0f 2 Help Desk Support 2 of 2 Click to leave feedback
i Terms of Service (= Planned ITS Outages ... © My Printing Tools : R Self-Service (Em... : A
: — 2~ My Print Center : Employee Self-Service
StUdentS This computer system is Dear Campus Community, @ Banner Time Entry,
the property of Yeshiva Add BuRds v Employment, Payroll and
. . ) Leave Balances
University. All use is The ITS 2024 planned outages w Printing
z : o 2 will start on Stars Out
subject to the University’'s Saturday unlil§:am Mandiy General Self-Service
. How to Print Your @
IT Handbook and other e, ) i Personal, Contact Info and
) o unless specified differently: ® oW Do currants Direct Deposit

applicable policies. By
3 logging into and using » January 6-8 Pharos Instructions
el Resources this system, you * February 10-12 ® (How to Release a

acknowledge your * March 9-11 Print Job)

* April 6-8

aareement with, and 5 2 L ESaE 47 s

NOTE: To display the ‘Home’ menu, click on the ‘Mani Menu’ located on the top left. The ‘Home’ menu lists ‘Cards’ that holds applications links and displays information
about system available to you, such Term of Services, Self Service (Faculty / Advisors), Planned ITS Outages, Banner time entry, Payroll, Employee and Printing tools,
etc. Frequently used ‘Cards’ can be customized and added on your home page. Select ‘Employee’to view the content available to you.




ITS Supported

Software

Banner Tools (VPN Required)

Banner 9

Banner Password Reset
CALI - YU File Transfer9
Argos 9

Intellecheck 9

Statistical Software
e Wolfram Mathematica
e SPSS

* STATA

* AtlasTi

* R Studio

* Examsoft - Examplify
*  OpenlDK

* Panopto

* Slack

* Barllan - Responsa

* Asana

* Camtasia

* Local Printers and Drivers
(Printers at Home)

Employee Tools

Employee Self-Service
General Self-Service
Timeclock Plus
BenefitFocus
Cornerstone

PageUp

YU Shutlle

Facilities Work Order
Benefit Enrollment Forms

Cyber Security
Windows Defender
Malwarebytes

AVG Virus Protection
Avast Antivirus

Adware Antivirus & Ad Block

Office 365

MS Outlook

MS Teams

MS Word

MS Excel

MS Forms

Adobe Acrobat Pro
PowerPoint
OneNote

Papercut

Recommended
Browsers
Google Chrome
Microsoft Edge
Safari

Apps are listed in the "Company Portal"



Microsoft Office 365 License & Applications

All active employees are provided with an Office 365 license which allows the use of Office products (Word,
Excel, PowerPoint, etc.) on your computer, mobile, or on the web.

=  Go to Office.com, Click the “Sign in” button.

= Sign in using your YU Email address as a username (xxxxxxxx@mail.yu.edu) and your YUAD password.

= Click on the "Install Office Apps" button to download Office365 apps — good for up to five devices
[desktops, laptops, smartphones].

= OneDrive cloud to store files and co-edit documents.
= Microsoft Teams to collaborate with members of your team or other departments.

= Live edits with others, great for projects and peer review: 2



PaperCut Print Management

PaperCut Print Management - is a print management software solution designed to help Yeshiva University efficiently manage their printing and copying resources.

How To Sign In:
3. You can release your all or your Print jobs by clicking the Print all button

By using your ID Card/Badge o You can also selectively release specific jobs

Once you are at the MFP, tap your YU ID card/badge on the proximity card reader. The proximity card reader will be in 4. Tap your ID to Sign-out

two possible locations based on the printer model. o If screen is idle for 1 minute, you will be automatically signed out.
NOTE: For ease of use, a label “Scan ID Badge Here” has been placed on the copier. Releasing Specific Jobs

s Forthe Large MFP (Alta-Link), tap the card reader is on the top left

* For the Smaller MFP (Versa-Link), the reader is on the front. 1. Onceyou have signed in, the following screen will appear

Choose the "Print Release" button to selectively release specific jobs

PaperCut/ Your Name [

L Pt et pemdin puinsme. L wean ot m

— . "
— ===

Print Release Access Device

N

To Sign in using your YU email address

If an ID Card/Badge is not available, you can still log in manuall 3. Select the jobs to print by clicking on the box to the left of the print job.

4. Click "Print" to release the selected job(s).
2. axihe Enter Username prompt, anter vour YU srmall addcess i Papercuthr” vouritiame | |
3. At the Password prompt, enter your YUAD password (same as |nsideTrack/Canvas) Seloct at jobs C
Releasing all your print jobs - : g ‘
1. Once you have signed in, the following screen will appear n

2. Press on the "Print Release" Button

PaperCut o Your Name [»

1 priotjub pendiog release 1 pege fotel

5. Tap your ID to Sign-out

E ‘D' \ n o If screen is idle for 1 minute, you will be automatically signed out
—
[— I —|

Print Release Access Device Scan



PaperCut Mac Installation

5.

6.

7.

Go to www.yu.edu/itsportal and click on papercut in the left-hand navigation bar.
Click on the “Papercut Software — Mac” located on the right-hand side of the papercut page.
o This will prompt the download of the software.
Locate the downloaded software on your Mac and double click on it to launch it.
You will then see the PaperCut Print Deploy Client window pop up, double click on the “PaperCut Print Deploy
Client.pkg” package to start the installation.

9.
Click continue through the installer prompts, then click the blue “Install” button.
o This will prompt you to enter your Mac password.
o Once entered, the install will start automatically.
You will see a pop-up during the install process that looks like the screenshot below. Click “OK”
“Installer” would like to
administer your computer.
Administration can include
modifying passwords,
networking, and system settings.
Don't Allow OK
Once the install is completed, you will see a successful message like the screenshot below.
Click “Close™.
The installation was completed successfully.
11.
12.
llation Ty
stallation - - 13.
nstaliatio The installation was successful. 1ia

Summary

Tt

8. In the menu bar on your mac, look for the papercut icon (see below).
o Click on it and select “"View Printers”

You will then be prompted to sign-in. Click “Sign in with Microsoft”
o  This will launch a web browser to Office365 and you will login like usual with your YU credentials.

10. Once signed in successfully, you will see the following message:

PaperCutp

All signed in and ready to print!

™

Locate the document you would like to print, then print it (Menu > File > Print) or (CTRL+P).

In the printer options select one of the following printers depending on if you are a faculty, staff, or student.
o Faculty/Staff: Employee — Find Me Printing — Xerox
o Students: Student — Find Me Printing

Select "Print" and the print queue should pop up.

Once the progress bar completes, go find a printer, scan your badge and you can release your prints.



What's New @ YU

Employee Orientation

The fiber network that links all the YU campuses was upgraded in July 2023. This change also
increases bandwidth to our Microsoft cloud tenant for Office 365 and Teams, Oracle cloud (Banner),
Google, Zoom as well as other providers. This network upgrade also decreases the number of "hops"
to cloud entities, so on-campus YU users should see a quicker reply when using many applications to
off-campus providers.

Classroom Computer Upgrades

Windows 11 has been the standard on new laptops since Fall 2022. All ITS-managed devices will be
upgraded shortly or have already been upgraded to Windows 11. This update will occur
automatically.



YU Instructure Canvas

All classes are taught through Canvas. Canvas is where you will upload ?@'Yeshiva University
assignments, see announcements, and access Zoom sessions. N

Sign in
Visit: https://yu.instructure.com e o ermal address
Sign in with your YU email address and hit Next. Enter your YUAD Can't access your account?

password and hit Sign in.
Back Next

For support contact (866) 570-3034 or email: info@canvaslms.com

Please logon with your YU email address and YUAD
password. If you need assistance logging in, contact
the YU Helpdesk at 646-592-4357. For non-urgent
questions, e-mail helpdesk@yu.edu.

Canvas Community is an online forum that helps users with tips and
guides on how to use every function in Canvas. Click on the link below
to learn more about Canvas:

https://community.canvasims.com/t5/Instructor-Guide/tkb-p/Instructor

ITS 16


https://yu.instructure.com/
mailto:info@canvaslms.com
https://community.canvaslms.com/t5/Instructor-Guide/tkb-p/Instructor

Canvas Includes:

* Course Syllabus.

e Course Announcements and Grades.
* Course Materials and Assignments.

* Access to contact faculty and students.

ITS 17



Canvas Dashboard

&« C @ https;//yu.instructure.com

Dashboard :
To Do
Nothing for now Upcomlng
Assignments or
R t Feedback
Sourses, Nec:n . B Important Dates
Notifications, and othing for now

Announcements
posted by professors

View Grades

=]
=

Accounting Principles |

Classical Jewish History
ACC-1001-261

JHI-1200-1B3 View Posted Grades
@ Spring 2019 Fall 2018
ey 22 N 4 N O
Messaging Inbox

= Student-to-Student
= Student-to-Teacher

Elementary Spanish |

Elementary Spanish 11

SPA-1102-331
Spring 2019

SPA-1101-331
Fall 2018

ITS

18



Canvas Class (Student Perspective)

Home
Syllabus
Announcements
Zoom » Welcome
Course navigation Modules
column. This is where Assignments
students can interact Quizzes » Week 1
with all materials Discussions
available to them within Grades
the course. banopto v Week2
Library Resources Please Read the following
and E-Reserves
& Aticle Link & Course Modules are a popular design

5 Dscssiont element to split course materials into
Iscussion

weeks or chapters for students to
Chapter 2 digest.

¢ Discussion 2

& Library Resources =

Chapter 2 Quiz
10 pts

ITS 19



Zoom for Faculty

= All YU live sessions are taught zZoom
within Zoom.

{d Home Appointments

Your current Time Zone and Language are (GMT-4:00) Eastern Time (US and Canada), English £

= You will be automatically

provisioned Wlth 3 YU Licensed Upcoming Meetings Previous Meetings Cloud Recordings
Zoom Account | | |
Start Time Topic Meeting ID
u Canvas integrations With Zoom TOday (Recurring) Samme Meeting 969 5410 6232 Join
. 11:00 AM
allows for easier management
and links directly in Canvas LMS. Tomorrow (Recurring) Sample Mesting 066 5410 6232
11:00 AM
= Students can access this by Thu, May 11 (Recurring) _
11:00 AM Sample Meeting 969 5410 6232

clicking on the "Zoom" link within

thel I COUrse. Fri, May 12 (Recurring)

Sample Meeting 969 5410 6232
11:00 AM

ITS 20



Wilf Campus Labs Locations and Hours

Buildin Number of
8 Computers

Mon — Thurs:
9 AM - 8:00 PM
Friday:

9 AM - 2:30 PM
Sunday:

9 AM - 5:00 PM

Belfer Hall

Gottesman
Library

Morgenstern
Muss

Rubin

1105

Entire Library

Basement Lounge
262

207

20 Windows PCs

25 Win pcs, 5 Macs, 4
Blomberg Terminals,
6 Yulis machines

7 Windows PCs
1 PRS

1 PRS

ITS

N/A

5 Color/B&W
printers, 2
Color/B&W Multi-
Function copiers

1 B&W
1 B&W

1 B&W

Click here for
Library Hours

24 Hours

21


http://libguides.yu.edu/LibraryHours/Wilf

Beren Campus Labs Locations & Hours

Bt Number of
8 Computers

1 AIO Desktop 1B&W
215 Lex Ave. 312 30 AlO’s Desktops 1 B&W oper D"l'l;i‘:‘rgs e
Art ?:oﬂaggrgoom Art Li;’ iCI\I,Iaasz;oom 2 Color Printers
North Wing Library 4 AlO’s Desktops 1 cQ1|o|3rg|;‘|l'\i,nter
Student Lounge 2 AlO’s Desktops 1 ColloE%:‘liY\ters

Room 318 (Lobby/Hallway Area)

ITS 2



Resnick Campus Labs Locations & Hours

Buildin Number of
& Computers

10 Student Lab
C-0 Computers PaperCut printer
Mon - Thurs
B - The OTD/Katz OT N/A 8am — 8pm
library

Mon - Thurs

Van Etten 5B-21 Student Lounge PaperCut Printer 9arr;:—. 5:30pm
ridays

9am - 1:30pm

Ferkauf 508 1 Testing Library N/A Wednesday
Computer 9am - 5:30am

ITS 23



Accessing Computer Labs

* To login to lab computers use your YU email address and YUAD password.

* CRITICAL: DO NOT save files on Lab computers.
* |nstead, save files on OneDrive.
* When you are finished using the computer, please log off.

e Unsaved work will be lost.

ITS 24



ITS Resources & Guidelines

Guidelines for Acceptable Use of Computer Resources

All email is property of Yeshiva University.

When changing your password, use complex passwords and
change it regularly, see Password Policy & Management.

NEVER share your password with anyone.

You are accountable for all activity using your accounts,
including confidential data. Avoid transporting sensitive
information.

Each user is responsible for posts to Social Media.

Delete any spam or suspicious emails. If you reply to these
messages, immediately notify the spam@yu.edu,
or helpdesk@yu.edu

Want to learn how to use classroom technology? click here
AV Calendar to make an appointment with a technician.

Encryption & Remote Access

All ITS computers are encrypted.
All faculty/staff are automatically setup for VPN.

For proper disposal of data, contact the ITS Help
Desk, helpdesk@yu.edu or call them via 646-592-
4357 / 646-592-HELP

Conduct communications with all personal using your
YU email account.

ITS will NEVER ask for your password or any
confidential information!

For more information visit the YU Administration,
Faculty, Staff ITS Handbook



https://yuad.sharepoint.com/sites/ITSPortal/SitePages/Password-Management.aspx?web=1
mailto:spam@yu.edu
mailto:helpdesk@yu.edu
https://outlook.office365.com/owa/calendar/ITSOfficeHours@yu.edu/bookings/
mailto:helpdesk@yu.edu
/sites/default/files/inline-files/ITS%20handbook%20-%20Admin%20Faculty%20and%20Staff.pdf
/sites/default/files/inline-files/ITS%20handbook%20-%20Admin%20Faculty%20and%20Staff.pdf

ITS Office Hours & Phone Number

Office Location: YU TechHub BH 6" Floor Lobby
2495 Amsterdam Ave
Email: helpdesk@yu.edu
Phone: 646-592-4357 Teams 4357
FAQs and Web: yu.edu/itsportal
HelpDesk Contact YU Helpdesk for assistance 24/7

ITS 26



Summary of Services

What ___[Site ________|Usemame ___|Password _lServiee

Find ID

InsideTrack
Printing
Canvas
Office 365
Computers
YUWireless
ITS Portal

yu.edu/findID

Insidetrack.yu.edu
Printing.yu.edu
yu.instructure.com

office.com

yu.edu/itsportal

YU E-mail address
YU E-mail address
YU E-mail address
YU E-mail address
YU E-mail address
YU E-mail address
YU E-mail address

ITS

YU password
YU password
YU password
YU password
YU password
YU password

YU password

Last name, Banner ID, or SSN to login
to University systems and set a strong
password.

Register/Schedule/Transcripts
PaperCut Printing

Course management

Word, Excel, PowerPoint, OneDrive
Internet

Wireless Internet On Campus

FAQs, IT Work Study, etc.

27
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